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Introduction to Excel
A WORKBOOK FOR STATISTICS STUDENTS 

Excel is an extremely powerful tool that has many applications in the business world. 

In this workshop we will touch on some of the features of Excel. It is not intended to turn 
you into an Excel expert, rather to give you some knowledge and familiarity of its 
capabilities, jargon and basic features. Help, Google and on-line courses can all be used to 
enhance the knowledge you gain from this workshop. 

There are multiple ways to do things in Excel – we will show you some of these.  

Each activity in the workbook has: 

(a) instructions for the steps 

(b) information about what to do with the mouse/keyboard to follow the instruction.  

(c) a picture so that you can see you are correct 

To complete the workshop, you will need access to the data file “consultation data”. 

This workbook was developed for MS Excel 2010 
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EXERCISE 1 – BASICS 
In this exercise we are going to 

 

(a) learn about Rows, Columns and Cells 
(b) enter data 
(c) save data 
(d) add data and format the total 
(e) find the minimum and maximum of a set of data 
(f) use conditional formatting 
(g) add/delete rows 
(h) change column widths 

 

OPEN EXCEL 

Double click on the Excel icon on the desktop. You will obtain the following screen: 

 

 

 

ROWS, COLUMNS AND CELLS 

Spreadsheets are arrays of rows and columns. The rows go across (row the boat across the river) and the 
columns are vertical. Rows are identified by numbers at the left edge and columns are identified by letters at 
the top of each column. Where each row and column intersects is called a cell. Cells are identified by the 
column and row letter/number combination, so you can see that the cell highlighted by the rectangle outline, 
which is where anything you type would be entered, is called A1 because it is in column A and row 1.  

 

When you move the mouse around in Excel, it takes different shapes, depending on what you are doing (it is a 
blank white cross while you move it around). If you click in any cell, that cell will be highlighted with a 
rectangle outline, and its name (such as E2) will show in the Name Box at the left, just above the column letters. 
As you type into the cell, what you type is also shown in the formula bar, to the right of the Name Box. These 
are shown in the next diagram: 
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ENTERING DATA 

Charlie has the results for 10 students for the mid-session exam. The results are: 

78,67,78,88,79,65,82,69,82,92 

 

Enter the data into Column A of the spreadsheet, as follows: 

Click your mouse in cell A1 (This cell will be highlighted with a rectangular outline.) 

Type 78 into A1 

Press Enter. The highlighted cell will now be A2. 

Type 67 into A2. 

Press Enter. The highlighted cell will now be A3. 

Type 78 into A3 

Press the Down Arrow key. The highlighted cell will now be A4. You have just seen that Enter and the Down 
Arrow key do the same thing when entering data. 

 

Enter the rest of the data. 

 

 If you make a mistake, you can use the Backspace key, or the Undo button. 

 

 

Name Box 

Formula Bar 

Cell E2 
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SAVE THE FILE TO THE DESKTOP 

Click on File 

 

 

Click on Save As 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select This PC, then Desktop. Type “Your name” (eg “Alison”) in the Filename box. 
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Click Save. 

 

CALCULATE THE TOTAL MARKS  

Click in A11 

Click on the Autosum button 

 

 

 

 

 

 

Your screen should look like this: 

 

Press Enter (or you can click on the tick to the left of the formula bar). The total should be 780. 

Note the formula =SUM(A1:A10). All Excel formulae start with “=”. This tells Excel to 
calculate.  

SUM tells Excel to add up  

A1:A10 tells Excel to use the cells from A1 to A10 
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FORMAT WITH A BORDER 

To format the total 

 
Click on the total 

In the Home Tab, Font Section, click on the little arrow next to the Border Box. 

Click on Top and Double Bottom Border 

 

This is what it should look like: 

 

CALCULATE THE AVERAGE 

Click in A12 

Click on the Formulas tab 

There are lots of formulae in Excel 

 

Select Insert Function. Note there is an explanation of what the function does. 

 

Click AVERAGE. Then Click OK. You will see the result and the numbers it is going to average. 
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Something is not right here. When we entered the data, all values were less than 100. Therefore, the average 
can’t be more than 100. Excel has included the total (780) in the data as it is using A1:A11. We need to change 
the range. 

Click in the Number1 box and make changes so that it says A1:A10. 

 

The result is now showing as 78. (Remember the total was 780, there are 10 pieces of data so the average is 
780/10 =78). This looks right. Click OK. 

 

CALCULATE THE MAXIMUM AND MINIMUM 

Maximum 

Click in A13. Select Formulas Tab, Select Insert Function, Select MAX. (Hint, you will have to type 
“maximum” in the search bar and look for MAX).  

Click OK. The screen will look like this: 

This doesn’t look right as the 
maximum isn’t 78. It should be 
92. Excel is showing 78 as it is 
only looking at the number in 
A12. We need to tell it to look 
from A1:A10. 

Click in the Number1 box. 
Delete A12. 

Click and hold down the left 
mouse button on A1 and drag it 
down to A10. 

 

 



 

  

 

 

 9 | INTRODUCTION TO EXCEL 

 

Make sure you are only doing A1:A10. Click OK. The answer should be 92. 

 

Minimum 

Click on A14. 

Click Formula Tab, Select Insert Function, Select MIN. Make sure you are only using A1:A10. Click OK. 
The answer should be 65. 

 

CONDITIONAL FORMATTING 

We want to quickly see who scored less than 75 and who scored more than 90. This is only formatting for 
visual presentation. It doesn’t change the underlying data. 

 

Scores less than 75 

Highlight cells A1:A10. 

On the Home tab, Styles section, Click Conditional Formatting icon 

 

Select Highlight Cells Rules, Select Less Than. The screen should look like this: 
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Type 75, click OK. All the scores that are less than 75 should now be red. 

 

Scores greater than 90 

Click on A1 and highlight the cells A1 to A10 again. 

Home tab, Styles section, Click Conditional formatting icon. 

Select Highlight Cells Rules, Select Greater Than. The screen should look like this: 

 

Delete 78.5 and type 90. 

Select the drop down arrow on the edge of the box 

Choose Green Fill with Dark Green Text, click OK. 

 

The sheet should look like this: 

 
What happens if you change 88 (cell A4) to 98? 

 

Remove conditional formatting: 

Highlight the cells (A1:A10) 

Click on Conditional Formatting 

Select Clear Rules 

Select Clear Rules from Selected Cells 
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CHANGE THE NAME OF THE WORKSHEET 

We want to change the name of the worksheet so we remember what it is. 

 

Double click on “Sheet1” in the tab name (at the bottom of the screen). 

Type “Marks”. Press Enter. 

 

CHANGE THE SIZE AND FONT OF THE DATA 

We want to change the font to Times New Roman and the size to 14. 

Click on A1 

Home tab, Font Section, Click on the little arrow next to 11 

 
 

Select 14. 

Now type “Times” instead of “Calibri”. The box will prefill with “Times New Roman”.  

Press Enter. This will change the size and font for cell A1.  

 

Applying changes to other cells using Format Painter. 

Click on the cell with the format you want to copy (A1). 

Home tab, Clipboard section, Click on Format Painter. 

 
The cursor will change to a paintbrush. 

Click A2. This will change the font size and shape of A2 to that of A1. 

To do this for all the other cells, click on A1, then click on Format Painter. 

Click on the left mouse button and drag the cursor all the way to A10. 
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ADD A ROW 

We want to add a row to put in a title. 

Click on the 1 at the front of Row 1. The whole row should be highlighted. 

 

Home tab, Cells Section, Click Insert icon,  

 

 

 

Click Insert Sheet Rows. Your sheet should look like this. 

 

 

 

 

 

 

 

 

 

 

 

Type “Mid-Session” in A1. It probably flows into Column B.  

 

CHANGING COLUMN WIDTHS 

Click on the line between Column A and Column B, (in the row of Column Letters). The cursor will change to 
a small vertical line with an arrow on both sides. 

Hold the left mouse button and drag to the right to widen the column – stop when the width is more than 30. 

 

To bring the column back to the width of the largest cell: 

Double click on the line between Column A and Column B 
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DELETE A ROW 

We want to delete the rows with the total, average, maximum and minimum values 

Click on 12, 13, 14, 15 at the front of Column A 

 

Right click, Select Delete 
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EXERCISE 2 – WRITING YOUR OWN FORMULA 
We now want to add the Final exam marks.  

They were: 72, 52, 95, 80, 90, 68, 0, 75, 80, 82 

The mid-session was worth 40% and the final was worth 60%.  

 

Excel uses the following symbols in formulae: 

(a) + add 
(b) – subtract 
(c) * multiply 
(d) / divide 
(e) ^ power 
(f) () brackets 

 

WRITING FORMULAE AND COPYING DOWN 

Type “Final” in B1. 

Enter the marks (see above) in B2 to B11. 

Type “Total Mark” in C1. 

We need to create a formula to calculate the total mark. 

In C2, type “=”. The “=” tells Excel that you are going to enter a formula. 

Click on A2. (This says “Use the information in A2”) 

Type *.4. (This says “Multiply by 0.4 or 40%”) 

Type +. (This says add) 

Click on B2. (This says “Use the information in B2”) 

Type *.6. (This says “Multiply by 0.6 or 60%”) 
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Your screen should look like this: 

Press Enter, or click on the tick in the formula bar 

We could repeat this for the next student but there is a quicker way. 

Click on C2. 

Hover over the bottom right hand corner until the cursor turns into a + 

Hold down the left mouse button and drag down to C11. 

Let go. 

 

The sheet should now look like this: 

 

 

 

 

 

 

 

 

 

 

 

You can see that the totals have calculated immediately. If you click on C7, for example, you will see the 
following formula in the formula bar: 
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You will notice that the A2 and B2 have become A7 and B7. In this case Excel is using Relative Cell 
referencing. When we drag down A2 in the formula, it becomes A3, then A4, then A5, etc. Note that 0.6 and 
0.4 are fixed. If we want to change these, we have to use absolute referencing. 

 

You can also copy formulas by highlighting from the formula to where you want it to copy to (in this case from 
C2 to C11), then in the Home tab, Editing section, click Fill, then Down. 

 

FORMATTING A CELL 

You might like to present the Total Marks to 2 decimal places. 

Click on C2. 

On the Home tab, Number section, Click on Increase decimal. (Hint: hover over the icons to get an 
explanation.) 

 

Another method: 

Click on C3, Right click, select Format Cell 

Click on Number in the Number Tab. Note the default of 2 decimal places, so you can click OK straight away. 

 

Use the Format Painter to format the rest of the cells. 
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IF STATEMENTS 

If a student didn’t get at least 60 on the final exam, they fail the subject. 

 

Type “Exam Result” in D1. 

Click in D2. 

Formula Tab, Click Insert Function, Click IF. 

 

 

Click OK 

Click in the “Logical_test box” 

Click B2. (This says “Use the information in B2”.) 

Type “>60”. (This says “greater than 60”.) 

Click in “Value_if_true” 

Type “Pass”. (This says that if B2 is greater than 60, “Pass” will be put in D2.) 

Click in “Value_if_false” 

Type “Fail”. (This says that if B2 is less than 60, “Fail” will be put in D2.) 

 

Your screen should look like this: 

You can change the 
“Select a category” box to 
“All” to see all the 
functions. 
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Notice the “Formula result = Pass”! Excel is telling you the result of the function so you can check it is what 
is expected. Click OK. The formula box will show: 

 

This shows the format of an IF function: IF(condition, what happens if it is true, what happens if it is false). 

 

Drag the formula down to D11 

 

ABSOLUTE REFERENCING 

We want to do some modelling on what happens if we change the weightings. For example, Mid-session could 
be worth 20% and Final 80%, or Mid-session could be worth 50% and Final also 50%. We could do this by 
writing a Relative reference formula each time. There is another way: using absolute referencing. 

 

Type “Mid wt” in G1. (This will be the weighting for the mid-session.) 

Type “Final wt” in H1. (This will be the weighting for the final.) 

Type “.2” in G2, and type “.8” in H2. 

Type “Model” in E1. 

Click in E2, Type = 

Click on A2, Type * 

Click on G2. Press F4. In the formula bar G2 will become $G$2. The $ fix the amount in the cell that is used. 

Type + 

Click B2, Type * 

Click on H2. Press F4 In the formula bar H2 will become $H$2. The $ fix the amount in the cell that is used. 
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Your formula bar should look like this: 

 

Press Enter. 

Drag the formula to E11 

 

Your spreadsheet should now look like this: 

 

 

Click on E7. The formula bar now looks like this. The absolute referencing has forced the formula to keep 
using the values in G2 and H2. 

 

Changing the weightings 

 

We now want to change the weightings. Type “.5” in G2, and “.5” in H2. The data change automatically. 
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Before finishing this worksheet, try to 

(a) Fit the columns to the correct width 
(b) Make the font size and type the same for all of the cells 
(c) Save the workbook 

 

DELETE COLUMNS 

We no longer need columns C, D, E, F, G, H. 

Click on C, hold left mouse button down and drag to H. 

Home Tab, Cells, Click on Delete icon, Click on Delete Sheet Columns. 
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EXERCISE 3 – CREATING CHARTS 
We are going to create a chart. To reduce data entry, we are going to use the same data. However, this time it 
is sales data for two different stores, one in Eden, one in Bega. 

 

COPY WORK SHEET 

We are going to create a new work sheet using the same data. 

Hold down Ctrl and Click on the worksheet tab called “Marks” 

As you drag, the cursor should become a small sheet with a +. 

Drag the small sheet behind the tab called “Sheet 2” – it will now be called Marks (2). 

 

Rename the sheet “Sales”, Press Enter. 

 

FORMAT CELLS – BOLD AND $ 

We are going to make the column headings bold and the numbers $. 

Click in A1. This will allow you to edit the cell contents. Type “Eden”. 

Click in B1 (or Tab or Right Arrow), type “Bega”. 

 

To make the headings bold 

Click in A1, hold left mouse button down, drag to B1.  

On Home tab, Font section, Click on B . (An alternative method: Highlight the row, then Click on B.) 

 

 

To turn the numbers into $ 

Click in A2. Hold left mouse button down and drag to B11. 

Home tab, Number section, click on $. 
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INSERT COLUMN 

These are sales figures for different months. We need to add a column with the months. 

 

Click on A at the top of Column A. This will highlight the whole column. 

Right mouse click, Select Insert. This will add a new column. (An alternative method is to use Home tab, Cells 
Section, Insert icon.) 

Click on A1, Type “Month”. 

 

AUTOFILL MONTHS 

Click on A2, Type “July”, Press Enter. 

Click on A2.  

Hover over the bottom right hand corner of A2 until a + appears. 

Hold left mouse button down and drag to A11. 

The column should fill with the names of the months. 

 

 

This is a really useful feature of Excel. If it can guess what the pattern 
is, it will autofill. It works with Days, Months, Years and numbers. 
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DRAW A CHART 

We want to compare the sales figures for the Eden and Bega stores. 

Click in A1. Hold down left mouse button and drag to C11. This will highlight all the data. 

Insert tab, Charts section, select Column. 

 

Select the first option in 2D. 

 

A chart will be placed on the work sheet and the Design tab will open. 

 

 

CHANGING THE LAYOUT OF THE CHART 

We can change the layout. We want a title for the chart, and titles on the axes, and we want to keep the “key” 
(or “legend”). 

 

Design Tab, Chart Layouts, click on the little arrow in the pulldown box: 

 $-
 $10.00
 $20.00
 $30.00
 $40.00
 $50.00
 $60.00
 $70.00
 $80.00
 $90.00

 $100.00

Eden

Bega
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Click on Layout 9. This one shows title, axis and key. 

Click on Chart Title. This will outline the box. 

Click in the box, Delete “Chart Title”, and Type “Sales Figures”. 

 

Click on the horizontal Axis Title. This will outline the box. 

Click in the box. 

Delete “Axis Title”. 

Type “Month”. 

 

Click on the vertical Axis Title. 
This will outline the box. 

Click in the box. 

Delete “Axis Title”. 

Type “Sales”. 

 

You can also do all this using 

Layout Tab, Chart Tools 

 

CHANGING THE CHART TYPE 

We can change the chart type. We now want a line graph. 

Click on the Chart. 

Design Tab, Type section, Click on Change Chart Type icon. 
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Click on Line 

Click on the 4th one 

Click OK 

 

 

 

 

 

 

You should get this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

MOVING CHART TO A NEW SHEET 

We want to move the chart to a new sheet.  

Design Tab, Location Section, click on Move Chart icon. 

 

 

The Move Chart box appears. 

 $-
 $10.00
 $20.00
 $30.00
 $40.00
 $50.00
 $60.00
 $70.00
 $80.00
 $90.00

 $100.00

sa
le

s

Month

Sales Figures

Eden

Bega
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Click on New Sheet 

Type “Sales Graph” in the box, Press Enter 

 

You will now have a new worksheet, called Sales Graph (you can see the tab at the bottom of the screen). This 
will have the graph on it. 

 

ADDING DATA LABELS 

We want to show the actual values on each data point. 

Click on a line between 2 data points, for example, between July and August for the Bega line. This will 
highlight each point. 

Right click. Select Add Data Labels 

 

Each data point will now show its value. 



 

  

 

 

 27 | INTRODUCTION TO EXCEL 

 

 

 
 

 

An alternative method: 

Click on a line between 2 data points, for example,between July and August for the Bega line. 

Layout Tab, Labels Section, Pull down the arrow on the Data Labels icon. You can then select where you 
want the label and other options. 
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EXERCISE 4 – ANALYSING DATA 
Use the data file “consultation data”. It shows fictitious data for students attending workshops. Data has been 
collected showing student surname, campus, age, gender, degree, and the number of consultations they’ve 
attended. 

We are going to analyse this data in a number of ways. 

 

SORTING 

Who attended the most consultations? We can sort the data to find out. 

 

Highlight the data from A3 to F15. 

Click on Data Tab, Sort & Filter section. 

Click on Sort. 

 

 

The sort selection box appears: 

 

Note the box “My data has headers” has been ticked. This means we have included the titles in the data. This 
makes it easier to do the sorting. 

 

Click on the arrow next to the Sort by box 

Select “Consults”. 
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The order box has changed from “A to Z” to “Smallest to Largest” because we are dealing with numeric data. 

 

Change “Smallest to Largest” to “Largest to Smallest”, Click OK. 

The list should now be sorted in descending numeric order. 

 

FILTERING 

We want a list that only has nursing students. 

We could sort the data and then delete or hide the other degrees. However, this destroys data that we might 
need later. Another option is filtering. 

 

Find all Nursing students 

Highlight all the data including the headings 

Data tab, Sort & Filter section, click Filter 

 

 

The arrows on the end of 
each column show that the 
filter function is on. 
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Click on the arrow next to “Degree”. You will see that Select all and each of the degrees has a tick. 

Click in Select All. This will remove all the ticks.  

Click in the box next to “Nursing”. Click OK 

 

The data now looks like this: 

 

Note that some of the line numbers are blue eg 4,7,12 and that they are no longer sequential. This indicates that 
data has been hidden. Also note the filter symbol next to Degree – this shows you that the data is filtered. 

 

Finding all Nursing & Science students 

Now we want to see all Nursing and Science students. 

Click on the filter next to “Degree”. 

Click on the box next to “Science”. This will include the Science students in the list. 

 

The data now looks like this: 

 

Filtering is a useful tool to clean data. If you filter by age, you will find that there is a “blank”. This should not 
happen. 

 

To turn off filtering 

Click on the arrow next to “Degree” 

Click in the box next to Select All 

Click OK. 

Check that there are no blue line numbers! 

 

Get rid of the filtering arrows. 

Click on the filter symbol in Data, Sort & Filter 
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SUBTOTALLING 

We want to know how many consultations were used by each Campus. To do this, we need to sort the data and 
then use the Subtotalling function. This is because Subtotalling works by adding items when there is a change 
in a variable. 

 

Subtotal by campus 

Sort the data by “Campus” in alphabetical order. 

Highlight all the data. 

From Data, Outline, select Subtotal 

 

The subtotal box appears 

 

Click on the arrow next to “Student Name” 

Select “Campus”.  

Click OK. 
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The data will now look like: 

 

This shows 22 consultations in all, 3 at campus Big, 11 at campus Small and 8 at campus West. We can see 
this more easily by clicking on the 2. 

 

 

To remove the subtotals 

Data tab, Outline, Select Subtotal. 

Click on Remove all. 
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PIVOT TABLES 

We want to know the number of consultations by gender for each degree. 

 

Highlight all the data. 

Insert tab, Tables section, Click on Pivot Table ,and Pivot Table again. 

 

The Create PivotTable box appears 

 

 

We want to use the same worksheet. 

 

Click on Existing Worksheet 

Click on A18, then OK. 

The page looks like: 
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In Pivot Table Field List, (on the right of the screen), click in the box next to “Gender”. It puts “Gender” under 
Row Labels. 

Drag “Degree” to column labels, Drag “Consults” to Values. It automatically sets this to Sum of Consults. 

 

The data selection should look like this: 
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The Pivot Table looks like: 

 

Now we can see that there were 12 consultations with females (not 12 females had consultations because we 
know from the data that some had more than one), of these, 4 were in Commerce, none in Education, 3 in 
Maths, 3 in Nursing, 2 in Science. 

We can also see that at least one student identified as Gender X. They didn’t have any consultations. 

 

Using count instead of sum 

We can redo the pivot table to see how many students we had information about. 

Click on the Pivot Table to bring up the Pivot Table Field List (if it is not still on the screen). 

Click on Sum of Consults. 

Click on Value Field Settings 

Click on Count 

Click OK 
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The Pivot Table now looks like this: 

 

This shows that the data contained 6 Females, 5 males and 1 X. Of the 6 Females, 2 were in Commerce, none 
in Education, 1 in Maths, 2 in Nursing and 1 in Science. We can’t say that all of these had consultations because 
we know that the data includes people who had 0 consults 

 

We can remove the 0 consults from the data by applying a filter. 

 

Applying a filter to a Pivot Table 

Drag Consults to Report Filter 
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This changes the Pivot Table to: 

 

Select the arrow next to “Consults (All)” 

Tick the box next to Multiple Items 

Untick the box next to 0 

Click OK. 

The Pivot table changes to: 

  

 

Compared to the previous one, we can see that only 10 of the 12 students in the data set had consults. 

 

Pivot tables are very powerful tools to analyse data. 

 

TIPS: 

(a) Make sure you understand your data. Know what you expect to see. 
(b) Be clear about the question you are asking 
(c) Check the results – from what you know about the data, do they make sense? 
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WHERE CAN I FIND MORE HELP? 
(a) Google your query. For example, “how do I make a Pivot Table in Excel 2010?”. Someone, somewhere 

will have posted something! Good for specific questions. 
(b) Use the Help Link in Excel. Good if you know the term. 
(c) Videos on the internet, for example, Khan Academy, Excel is Fun YouTube. Useful to see how it is done 

– generally, one item per video 
(d) Excel courses on Lynda.com. This provides access to an entire professional on-line course for software. It 

is free to UOW students. From the Library Website, select A-Z Databases, select L, select Lynda.com. 
Search for Excel courses. (You will need to set up an account.) 

(e) Help sessions with Learning Development.  

 

Published by Learning Development — University of Wollongong. Resources originally authored by Alison Sandwith during a project 
funded by the Student Services & Amenities Fee for Bega Campus in Spring 2015. 
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